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Building Tomorrow’s ExChange

All dBUG activities are made
possible by the efforts of
volunteers. The Resource Center
is not staffed full time. It is open
during scheduled SIG and Open
House meetings or by appoint-
ment only.

Resource Center (RC)
1530 Eastlake Ave. East, Seattle.
South of Garfield St. and Eastlake
Veterinary.
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From d’Prez
SIGs Get Support
Last month, an overjoyed dBUG
Board approved Mark Jacobson as
SIG Coordinator. Jacobson vows
to give SIGs “a solid and
consistent foundation that will
allow each SIG to provide a
valuable experience to our
members and the community.”
He will work to increase SIG
attendance and to add SIGs.

A former Apple representative,
Jacobson now has his own
Macintosh consulting business.

Jacobson, the dBUG Board,
and MacNews thank Dick Carter
for his hard work in scheduling
and other SIG support.

It’s About Fun
dBUG member Joyce Schowalter
will be recruiting new members
and volunteers. She brings years
of experience with volunteer
organizations and marketing on
board. She says, “This should be
a blast. I’m looking forward to
bringing people together in fun,
rewarding activities.” Like to
help? The Volunteer Coordinator
Board position is still open.

Ken Winkenweder, dBUG’s new President

NO MAIN

MEETI
NG

IN JULY

As your new president, I believe
every member should be aware of
what’s happening with dBUG. To
keep you informed, I am bringing
back the president’s column in
MacNews. Each month, we’ll talk
about issues concerning dBUG,
progress toward our goals, and
other topics of interest to you.

First, I’d like to remind you that
dBUG is searching for a new main
meeting coordinator. If you know
of anyone who would like to get
involved with software companies
and hear about the latest products
first hand, please send them my
way.

Now for the big news. As I am
sure you are all aware, dBUG uses
the FirstClass software to run our
email and conferencing system,
the dBUG ExChange. dBUG had an
opportunity recently to upgrade to
the latest version of FirstClass at a
reduced price. The new version of
FirstClass has significantly
improved Internet support, and,
with dBUG’s future obviously tied
to the Internet, the board
approved the upgrade. Among
other enhancements, the new
software will upgrade our email
capability to let you use email
programs other than FirstClass for
your dBUG email. In addition, the
version of FirstClass we’re currently
using has not been supported for
two years, which will pose a
problem down the road.

So, what does this all mean to
you? We will be dropping the
direct dial-up lines, but don’t fret.
Although you will connect to the
ExChange via the Internet, you

will not need to buy an account
with an Internet Service Provider
(ISP) just to access the ExChange.
Those of you who are now dialing
directly to the ExChange will just
need to configure your computers
a little differently.

We plan to have training
sessions and volunteers to walk
members through the new
configuration, screen by screen.
We also plan to have a question-
and-answer session prior to the
next few main meeting presenta-
tions. By dropping the direct-dial
phone lines, we will improve

Be the first to read MacNews!
See current & recent issues
in Acrobat Reader format at
<www.dbug.org> and in the
Newstand and dBUG Mentors

folders on the dBUG ExChange.

by John Newhoff
dBUG’s September main meeting
will be titled ‘dBUG’s Favorite
Shareware,’ and we’d like to ask as
many members as possible to
participate. Your favorites will be
included on a CD-ROM that will be
available to members at a low
cost. We’ll be asking approximately
six people to demonstrate their
favorite piece of shareware at the
September main meeting.

Wanted:
Shareware

continued on page 5

continued on page 8
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Special Interest Groups(SIGs)
by Mark Jacobson
dBUG SIG Coordinator

Schedule changes are bolded.

4th Dimension SIG
4th Wednesday, 6:00 p.m.

Westwind Computing
Walt Nelson

dBUG BBS ExChange SIG
The ExChange Beginnings TeleSIG
teaches the basics of tele-
computing, with a focus on using
the dBUG ExChange.

4th Tuesday, 6:30 p.m.
dBUG Resource Center
Cherie Nickell

ExChange.com Planning
SIG
Meetings open to members about
the expansion and maintenance of
the ExChange.

1st Saturday, 11:00 a.m.
dBUG Resource Center
Curtis Snow

FileMaker Pro SIG
3rd Monday, 7:00 p.m.
dBUG Resource Center
Bruce Robertson

HyperCard/AppleScript
SIG
AppleScript and HyperCard—come
and explore the possibilities!

3rd Tuesday, 6:30 p.m.
dBUG Resource Center
DeForest Shotwell
dnshotwell@accessone.com

iMac SIG – New!
Internet Searching Techniques.
We’ll look at how to find the
information that you're looking
for on the Internet.

We’ll look at some of the
popular online search engines,
but also online dictionaries,
thesauruses (sp?) and other
reference “books” as well as
online newspapers, weather sites,
and White Pages.

1st Tuesday, 6:30 p.m.
dBUG Resource Center
Tim Hannon
First-time Mac owners:
Get a discount when you buy

a dBUG membership at the iMac
SIG!

Internet Intro
4th Monday, 6:30 p.m.
dBUG Resource Center
Nancy Ibsen
panic@jetcity.com

iRobot SIG – New!
3rd Wednesday, 6:30 p.m.
dBUG Resource Center
John Newhoff

Mondo Graphics/DTP
2nd Tuesday, 6:30 p.m.
Summer hiatus until fall

Open Friday
Bring something to scan. Surf the
Web. Bring a non-member.

Every Friday evening, 6:00 p.m.*
First Friday is new member
orientation
dBUG Resource Center

Open Thursday
Open discussion for dBUG
members and their guests.

Every Thursday*, 6:00 p.m.
dBUG Resource Center
Dick Carter

Software Developers
Workshop
A workshop (hands-on, if possible)
for beginning Mac programmers.
The topic is announced by email
and posted to the Software
Developers SIG folder on the
ExChange about a week before.
Feel free to bring an application or
source code you want to show off,
or just come and ask questions.
Please check the ExChange
prior to the scheduled SIG date
to confirm that the SIG will
meet and, if so, what the topic
will be.

2nd Saturday, 10:00 a.m.
dBUG Resource Center
James Jennings
jennings@halcyon.com

Virtual SIGs
dBUG also has active SIG confer-
ences on the dBUG ExChange:

Excel SIG
FileMaker Pro SIG
PageMaker SIG
Photoshop SIG
QuarkXPress SIG
WEB SIG
Word SIG

Personal Digital Assistant
(PDA) SIG - New!  Discussion
of Newton, Palm, and more.

Finding these SIGs is easy:
■ Double-click the dBUG ExChange

button on the ExChange
desktop.

■ Double-click the dBUG Clubhouse
icon.

■ Double-click the SIGs icon.
■ To find the PageMaker,

Photoshop, and QuarkXpress
SIGs, double-click the Mondo
Graphics/DTP SIG icon.

Saturday had a few hours of
beautiful weather as I pulled into
the dBUG Resource Center parking
lot. Jay Heath was there before
me, and we enjoyed some sun as
we waited for the others to come.
Then Pam Lund arrived, followed
shortly by SIG leader Curtis Snow
and Dana Klein. Dick Carter walked
through the door just as every-
thing inside was set up.

These are the regulars at the
<ExChange.com> SIG. According to
Curtis, “We refer to it as the
‘ExChange planning committee’ or
‘X Plan.’”

After the business of blueberry
scones and croissants was sorted
out, Dana opened the meeting
with his announcement that the
board of directors has approved
the upgrade to the FirstClass
Server. Discussion ensued about
the nifty features of the new
software and the impact the
upgrade will have on dBUG
members as well as on the
organization.

As I listened to the talk, I was
very impressed by their depth of
knowledge and ability to envision
the issue from different angles.
They discussed how members and
dBUG as a whole would be
affected financially, as well as
timing the upgrade to coincide
with the move from using NetOS
as an ISP.

Next, we searched the Internet
for other Macintosh user groups
that are currently using the new
software, as well as the Web site
for SoftArc, the company respon-
sible for FirstClass. Curtis said this
was a typical format for this SIG,
discussing the issues first, then
searching the Internet for
information and ideas that might
benefit dBUG.

They also brainstorm ideas for
the organization based on what
they learn from each other and
from the Internet; one such idea
was having a Web SIG that focuses
on content, rather than design.

Curtis states that the goal of
the committee is to have a world
class computer-mediated commu-
nication system for all dBUG
members to use as part of their
online experience. The ExChange
planning committee blends
experience from several different
perspectives together in a relaxed
atmosphere with proactive
thinking to minimize “surprise.”

Lest you get the impression that
this SIG is all work and no play, as
a reward for their efforts, Pam
found the URL for an online
version of Scrabble that was quite
entertaining.

Shelley Greer is a budding freelance
writer and a Seattle Knight.

Inside the ExChange
Planning SIG
by Shelley Greer

Notes:
Westwind Computing is at 510 NE
65th, two blocks west of I-5, on
the northwest corner of NE 65th
and NE Ravenna Blvd.

The MacNews calendar, SIG
updates, and the current month’s
events PICT online calendar are
accurate at the time they are
published.

*Please call the dBUG
InfoLine—206-624-9329—for
last-minute changes and
additions.
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Computer Terms Demystified
This is the first of a series of
columns by Pete Miner, a writer
cleverly disguised as a truck driver.
His column, Miner Thoughts,
appears in My Mac Magazine, a
monthly online magazine. To find
out more about My Mac Magazine
or to subscribe (it’s free!), visit
<http://mymac.com/>. Now, here’s
Pete:

This month catches me without
a story to tell. Of course I could
have composed a fictitious yarn
replete with intrigue and adven-
ture about some non-human life
form that decided to take up
residence inside my Performa and
slowly but methodically took over
my mind. But alas, that sort of
prevarication is not what the half-
dozen or so regular readers of
Miner Thoughts have come to
expect from me. No, you read my
column because what you learn
here gives you that extra edge

when dealing with today’s
computerized society. You rely on
me to give you those little tidbits
of information that will always
keep you one step ahead of that
ever present, self-proclaimed
computer guru in your workplace.
And hey, I’m happy to oblige.

Today you will learn the
definitions of 50 of those
sometimes pesky and hard to
understand computer terms that
we all too often trip over. So sit
back, relax, and scroll your way
through an education you couldn’t
get anywhere else.
Balloon Help: When used properly

can prevent venereal disease.
Semiconductor: Truck driver.
Internet: A confusing place to be.
World Wide Web: An organized,

animated, colorful confusing
place to be.

Archie: Carroll O’Connor’s stage
name in All In The Family.

Hacker: Long time smoker that
makes disgusting sounds.

Drag and Drop: What we guys do
when our wives ask us to help
rearrange the living room
furniture.

Pre-emptive multi-tasking: If
you can walk and chew gum at
the same time without having
to think about it, you’re already
doing this.

Disk cache: Pennies, nickels,
dimes and quarters.

Backup: All computers are
different, but once you figure
out how to put yours into
reverse, you can do this.

Ethernet: Device used off the
southern coast of Australia to
catch the elusive Etherfish.

EtherTalk: Language spoken by
Australian fishermen to attract
Etherfish.

Chooser: The person who gets to
pick it.

Finder: The person who gets to
keep it.

SCSI (Scuzzy) port: Inferior grade
of wine, e.g. Muscatel, Ripple,
Mad Dog.

Apple Guide: A long wooden tray
with sides, used by apple
pickers to collect their fruit
from the tops of trees.

Interface: Your skull.
QuickDraw: McGraw’s first name.
Modem port: Coastal area where

modems take refuge during bad
storms.

Mouse pad: Where mice are
launched.

Virtual memory: Something none
of us has enough of.

RAM: Dodge pickup.
Disk First Aid: Available at your

local chiropractor.
Megabytes: How we eat when

we’re in a hurry.
Hot Link: You can get one with a

Coke for $1.50 outside any
COSTCO, ball park or stadium.

HTML (Hotmetal): What happens
to my brake drums when I come
down a hill too fast.

Cursor: Foul-mouthed person.
Spreadsheet: Need to do this

before making the bed.
Word 6.0: Slowest moving object

known to man.
Bill Gates: God, in some religions.
ClarisWorks: So do the rest of us.

Database: Where data comes in
for a landing.

Font: A receptacle for holy water.
Fuzzy logic: How we think at 2:00

AM after the bars close.
Binary: A two star solar system.
PC Exchange: What one does when

he finally realizes he should
have bought a Mac.

Bit: Past tense of bite.
Webmaster: The spider that wears

the pants in the family. Usually
the female.

Icon: Bill Gates.
IP : We all do.
Laptop: Area just below Bob (Big

ol’ belly).
Browser: Someone who’s just

looking.
Compiler: Collector of stuff.
Cyberspace: Where the Cyberians

live.
Crash: What one does when they

can’t stay awake any longer.
Silicon: A non-metallic element

occurring extensively in the
earth’s crust in silica and
silicates, having both an
amorphous and a crystalline
allotrope, and used doped or in
combination with other
materials in glass, semiconduct-
ing devices, concrete, brick,
refractories, pottery, and
silicones. Atomic number 14;
atomic weight 28.086; melting
point 1,410 C; boiling point
2,355 C; specific gravity 2.33;
valence 4.

Internet Explorer: A computer
virus.

Floppy drive: Male libido with
problems.

Hard drive: Problem solved.
Insertion point: Don’t think I’ll

go there!

Feel free to use this glossary to
impress friends with your vast
knowledge of computer terminol-
ogy. If for some reason you would
like a complete academic glossary
of computer terms, I have stolen a
list containing hundreds of
definitions from the Internet and
have compiled it into an easy to
use A to Z DOCMaker file. Just
email me and it’s yours.

Miner Thoughts

by Pete Miner
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Slim. Stunning. Superfast.
With a PowerPC G3 processor running at up to 400
megahertz, and an even thinner and lighter design, the new
Macintosh PowerBook G3 Series gives you the ultimate
combination:

desktop performance in a notebook computer.

• 333 and 400Mhz clock speeds

• 14.1" active matrix screen

• up to 5 hours on one battery

• 5.9 pounds

Apple Macintosh PowerBook G3
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The Free-Range Mac
Tips and Comments
July 1999 - Compiled by Bill Rabel
Moving iMac Files
By now we all understand that the
iMac lacks a floppy drive and SCSI
port, making it difficult to transfer
files from the iMac to another Mac
by any means other than Ethernet
or email. However, there is another
way: Modem to modem. Here’s how
to do it in
ClarisWorks
[AppleWorks].

String a
telephone
cable between
the inputs of
both modems
(the port
meant for the
incoming
telephone line,
not the one
that goes to
the tele-
phone).
Launch ClarisWorks on both Macs
and open a new communications
document. Configure the settings
for both modems this way:

Method: Serial Tool; Baud Rate:
57600; Parity: None; Data Bits: 8;
Stop Bits: 1; Handshake DTR &
CTS; Current Port: The port your
Mac’s modem is attached to
(internal for the iMac).

Set the protocol to XMODEM
Tool, the method to MacBinary,
and the Transfer Option to
Standard. On the receiving
machine, select Preferences from
ClarisWorks Edit menu. Choose a
receiving folder in the Topic for
Communications area.

Select Open Connection from
the Session menu and on the
sending Mac type ATD. On the
receiving Mac, type ATA. When the
modems are connected, click the
Send button from the Session
menu and choose a file to send.
Now select Receive File from the
Session menu on the receiving
Mac. The Macs will now send and
receive the file you’ve chosen.

Note: To send a lot of files at
one fell swoop, gather the files
you want to send in a single folder
and compress that folder with

DropStuff. Once the folder is in
StuffIt format, it becomes a
single, transferable file.

- Macintouch, San Diego MUG

Office 98 Buggy Wizards
According to MacFixit, Microsoft
has acknowledged bugs in Word

Freeware File Expansion
The latest version of StuffIt
Expander has an annoying dialog
that appears every time you
unStuff a file. It urges you to buy
their StuffIt Deluxe upgrade.

An alternative freeware product
is MindExpander from MindVision,
<http://www.mindvision.com/>.
MindExpander (v 0.91) expands
MacBinary, BinHex, StuffIt, Zip
(soon), and other files.

- Excerpted from Mouse Droppings,
Corvallis MUG

Word and PowerPoint Bugs
It’s very clear that there
are serious memory
allocation issues affecting
both Word and PowerPoint
[98]. Increasing memory
allocations upwards to 20
megabytes and beyond
have been the only
workaround in dealing
with the Red X issue. I’ve
summarized below some
of the more critical bugs
worth mentioning to your
readers:
1. PPT 98 presentations
saved as PPT 4.0 usually
fail with “out of memory”

messages. Allocating as much as
40 MB of memory to the PPT 8-4
translator library may be
necessary. In one instance, even
more was necessary.

2. Red X of Death issue is
becoming an everyday occur-
rence. Fast saves seem to be the
culprit. There is still no official
response from Microsoft that we
are aware of.

3. Printing previous Word 5.1
documents in Word 98 (we have
close to 100 files so far) which
print with just one blank page.
The files print as they should
with Word 5.1 and 6.01.

4. PPT 4.0 files opened in PPT 98
and saved as PPT 4.0 lose their
bullet formatting. Bullets
change to “#” or “?”.

- Macintouch, San Diego MUG

G3 Notes
The HP DeskWriter 680C requires
the new version 9.4 driver. G3s fail
to connect to auto-sensing 10/
100Base-T Ethernet hubs or
switches. Apple recognizes this,
and is about to release a new
Ethernet driver update

- Macintouch, San Diego MUG

Acrobat Reader Tips
■ Go from page to page with the

Page Up or Page Down keys, or
the arrow keys.

■ To go to a specific page, press
Command-5, type in the page
number and press Return

■ To scroll within a page, push
Shift while using the arrow
keys.

■ Command-Shift-B hides [or
shows] the Reader toolbar and
Command-Shift-M hides [or
shows] the menu bar.

■ Press Command-Shift-L to fill
your total screen—no windows
or menu bar, just like a
presentation program. You can
still move from page to page by
using the up/down arrow keys.

■ You can zoom in and out by
using Command-L [and
choosing the magnification
you like].

■ If you choose Full Screen from
Preferences in the File menu,
you have a lot of presentation
options, like automatic page
advance, hide the cursor, pick
background colors, and select
from a bunch of transitional
effects.

- ProMUG MacViews

Netscape Bookmarks
In Netscape, you can save time by
setting your home page to open
to your Bookmarks file. Then all
your favorite Web pages are just
a click away. Here’s how:

Under the File menu, choose
Open File to locate the html
version of your Netscape book-
marks, titled bookmark.html (It’s
probably on your hard drive in the
System/Preferences Folder. If not,
look in your Netscape folder on
your hard drive). Highlight and
copy the bookmark’s URL (It will
begin with file://). Now go to
the Netscape Options [menu] and
choose General Preferences. In
the home page field, paste the
bookmark URL, and voila! The next
time you open Netscape, your very
own bookmarks appear, hot linked
and ready to use.

- Macintouch, San Diego MUG

Modem to modem data transfer

98’s Memo and Resume Wizards.
Using them on a G3 (and possibly
Power Macs) will cause a crash
once you click “Finish.” This may
occur with any Power Mac or clone
with 512 or more cache memory.
The workaround…: click on “Help”
instead of “Finish,” and then
select the top answer from that
Help roster.

Buggy Wizards Patch
[See the previous Tip.] Microsoft
has…produced a patch for this
problem. You can download the
patch at <http://
www.microsoft.com/macoffice/
users/freedl.htm/> and, there,
scrolling down to the section
called “Memo-Resume Wizard
Problem.”

This page, by the way, is an
excellent site to bookmark for
users of Office 98 for the Mac. An
even better Microsoft link for Mac
users is <http://
www.microsoft.com/mac/> which is
Microsoft’s area devoted to
Macintosh products, managed by
the enthusiastic Macintosh team
at Microsoft. They call their site
“Mactopia.”

- Macintouch, San Diego MUG
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When I decided to write about
Apple’s third series of G3
PowerBooks, I consulted the
experts at Westwind Computing.
Tyson Paxton, from Westwind’s
Corporate Sales, sat one of the
new “bronze” PowerBook models
side by side with its next older
brother and guided me on an in-
depth comparative tour.

Anatomy
Lesson
The first improvement I noticed
before we even opened the
PowerBooks. The bronze is a little
thinner and a lot lighter. I could
pick it up without any unladylike
grunts or those snapping sounds
from my lower back. It also has a
new push-button latch; with elder
brother’s pull-up latch, you’d worry
about breaking off the latch tab
every time you used it to lift the
top of the PowerBook.

Like its predecessor, the bronze
PowerBooks have bays for two
batteries. Although the new
batteries are smaller, the two of
them keep the bronze going up to
10 hours: 30 percent longer than
the older batteries. Too bad the
new batteries won’t fit in the older
PowerBooks. The battery bay on
the right side still doubles as a
bay for your CD-ROM or DVD-ROM
player or other peripherals. The
bronze PowerBook also comes with
a lightweight cap you can use
when the right bay is empty. Apple
ships the bronze PowerBooks with
Mac OS 8.6, which, Tyson reminds
me, also helps to lengthen battery
life.

In keeping with Apple’s vision,
the bronze PowerBooks have no
floppy drive. “Someone has to
force the industry to the next
level,” said Tyson. Then, like a
good salesman, he regaled me
with the availability of external
floppy drives.

You lose one PC card slot in the
bronze PowerBooks, but Apple
made up for that by building in
10/100Base-T Ethernet networking
capacity as well as a 56K V.90
modem. With the older models,
you had to buy a PC card to
upgrade to high-speed 100Base-T
Ethernet.

These are the first PowerBooks
to have USB ports instead of an
ADB and serial port. (Faster and
easier to use than ADB and serial
connections, USB can support 127
devices, using hubs to extend the
number of ports.) The bronze
PowerBooks will also support high-
speed FireWire cards. If you need
to connect your existing printer,
Westwind recommends the
Keyspan USB serial adapter, which
gives you two serial ports.

Apple squeezed all the ports
into a smaller space on the back
of the bronze PowerBooks and
moved the modem port there for
easier docking and improved
cooling. Because of the port
reconfiguration, however, existing
docking stations, like the
Bookendz dock, won’t fit the
bronze PowerBooks.

Speed and
Features
Having led me around the exterior
of the bronze PowerBook and its
older brother, Tyson opened and
booted them. First of all, can you
say “fast?” Can you say “400
MHz?” I’ll settle for a smug meep-
meep to all those Wiley Intel
Coyotes back there in the dust.
There’s also a 333 MHz configura-
tion, but more about that later.

You don’t sacrifice screen size
for speed, either; both bronze
PowerBook configurations have a
14.1” screen. There’s also double
the video RAM (VRAM), 8 MB. Not
only do you get more colors at
higher resolutions, but you also
get a two-monitor capability that
users have been longing for. Video
mirroring or simulscan (in which
your PowerBook screen matches
what’s on another monitor or the
big screen) is still a feature, but
it’s hiding in the bronze
PowerBook’s control strip instead
of in the Monitors and Sound
control panel. When mirroring, the
bronze PowerBook’s screen refresh
rate is 85 Hz at 1024 x 768
resolution, eliminating an
annoying flicker in the older
models.

You still have both 24-bit and
high-resolution S-video output
ports (so you can connect a TV)
and built-in 2D/3D graphics

acceleration through an ATI RAGE
LT Pro video controller.

When I tore my eyes from the
screen (no, we were not watching
DVD movies), I saw why these
PowerBooks are tagged the
“bronze” PowerBooks. The
keyboard is a translucent brown

minimum advertised price: $2,499
for the 333 MHz bronze, and
$3,499 for the 400 MHz bronze.

If you have questions or want
a test drive, the good folks at
Westwind will be happy to help.
All I can say is, meep-meep.

Bronze PowerBooks: Fastest Laptops Ever
by Tish Bailey

Bronze G3 PowerBook
Configuration Differences

Bronze G3 PowerBook
Configuration Differences

Processor speed 333 MHz 400 MHz
Backside level 2 cache 512 K 1 MB
Backside bus speed 133 MHz 160 MHz
Hard drive size 4 GB IDE 6 GB IDE
DVD-ROM built in No Yes

Apple Minimum
 Advertised Price $2,499 $3,499

accessibility and lower costs at the
same time.

For those of you who were
unaware, dBUG also arranges
Internet access for members at an
additional cost, which is less than
many ISPs charge. Along with the
change to FirstClass, dBUG will be
switching providers, which should
eliminate the busy signals that
some people have experienced.

When you buy Internet access
through dBUG, you get all the
services that most ISPs provide,
such as access to the World Wide
Web, newsgroups, and space for
your own Web site.

More to come, so stay tuned.
Your board is at work to make
dBUG more viable for you and new
members. We plan to grow as the
Internet grows. Drop me a note at
<winkie@dbug.org> if you have any
thoughts about dBUG!

Regards,
Ken Winkenweder
President

President’s
Column…
continued from page 1

instead of boring black. Function
keys now double as screen
brightness and contrast controls,
making the controls easier to use.

A tradeoff for the bronze
PowerBooks’ slim size and lighter
weight are smaller hard drives. The
400 MHz configuration comes with
a 6 GB drive instead of an 8 GB
drive. However, Tyson pointed out
that Apple will have a 10 GB drive
available soon, and may offer it as
a build-to-order option.

Eenie-meenie
Tyson finished my tour with a
look at the two bronze PowerBook
configurations. The differences
are shown in the sidebar. Both
configurations come with 64 MB
of RAM, expandable to 384 MB.
The 333 MHz bronze includes a
20X CD-ROM drive; the DVD-ROM
drive in the 400 MHz bronze also
supports CD-ROMS up to 20X. At
present, Apple does not offer
build-to-order options.

Tyson emphasized that, before
you choose which configuration to
buy, you should consider whether
you might want a DVD-ROM
drive—now or in the future. If
you want DVD-ROM, the 400 MHz
bronze is for you. The 333 MHz
bronze does not include it and, in
contrast to the older PowerBooks,
cannot be upgraded via a PC card.

Tyson’s grand finale was Apple’s

 K
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Much of the power of Microsoft
Word relies on your taking time to
create and modify its tools. Here
are a few tips to help you make the
most of Word.

Use Styles
A style sets formatting for a
paragraph or character. Paragraph
styles dictate fonts, bolding,
indenting, tabs, the amount of
space before and after the
paragraph, and more. Word comes
with default styles, but you can
change them or add new ones.
■ It’s a

good idea
to modify
Word’s
default
styles
rather
than use
different
custom-
ized
styles,
especially
for
headings.
Many
automatic
functions, such as building tables
of contents, are a snap because
they rely on default style names.
Word can use custom heading
styles to build tables of contents,
but only if you insert a special
field after each heading. This
takes time.

■ Word’s automatic bulleting and
numbering work best for lists
of one paragraph per bullet or
number. If you add paragraphs,
Word bullets or numbers them,
too. If you turn off numbering
for that paragraph, Word starts
the next numbered paragraph at
1. A more flexible approach is to
create hanging indent styles and
use them instead of the bulleting
or numbering feature. In Word
98 and Word 6, it’s easy to record
a macro that will insert your
favorite bullet symbol, followed
by a tab, and then apply your
hanging indent style to the
paragraph.

Use Templates
Templates (“stationery” in Word 5)
store document-wide formatting,

such as page and section layouts,
styles, toolbar buttons, and
macros. Every Word document is
based on a template. When you
push the New button on the
toolbar or press the command+n
keys to create a new document,
that document is based on the
Normal template, which is Word’s
default. Save styles, buttons, and
macros you use globally in your
Normal template.

If you customize some format-
ting or need special tools for a
particular type of document,
create a custom template. This
is easy, too:
■ Assemble or modify the

elements you want in a
document.

■ Click Save As on the File menu.
■ In the Save dialog box, click

the arrow to the right of the
Save As File Type box to display
a list of file types. In Word 98
or Word 6, click Document
Template. In Word 5, click
Stationery.

■ Save your template in
the same folder as Word’s
other templates.

To create a document
based on your new
template,  click New in the
File menu. Word will display
a list of templates; find
your template and click it.
Note: you can’t use the
keystroke shortcut or the
toolbar button to create a
document based on a
custom template.

Organize
Your Tools
You’ll be more efficient if you
customize Word’s toolbars. You
have more latitude with Word 6
and 98 than with Word 5.1, which
only has one toolbar.

Delete Unused
Buttons
In Word 5.1, you cannot remove a
button. Instead, you change the
command assigned to it as
explained in “Add Needed Buttons”
below. In Word 98 or Word 6, press
Option, press and hold the button,
release Option, and drag the
button off the toolbar.

Use Keyboard
Shortcuts
Learn the keyboard shortcuts for
the functions you use most often.
Then delete those buttons, too.
You won’t regret learning the
shortcuts for Cut, Copy, Paste,
Undo, Redo, Find, and Replace
since those shortcuts work in
many Mac applications.

Add Needed Buttons
Add buttons (or change them in
Word 5.1) for the functions you
use less often or for which
keyboard shortcuts are complex or
unavailable. Word 98 and Word 6
let you assign toolbar buttons to
styles and macros as well as to
commands.
To change buttons in Word 5.1:
■ Click the Toolbar arrow button

on the toolbar, then click
Customize.

■ In the Button Position list box,
click the button you want to
change. (Click on the arrowhead

to see all the
buttons.)
■ In the

Command list
box, click the
command you
want.

■ In the Button
list of icons,
click the
button face you
want.

■ Press the
Change button.

■ Press the Close
button.

To add buttons in
Word 98 or Word 6:
■ Click Toolbars in the View menu,

then click Customize.
■ The Save In list box

(Word 6 calls it Save
Changes In) shows
the templates that
are open. The default
is to save changes to
the Normal template;
if you are changing a
custom template, you
must click its name
for the changes to
be saved to that
template.

■ In the Categories list box, click
Styles or Macros to add a button
for a style or macro. Click All
Commands to add a button for
a command.

■ From the list that Word provides,
choose the style or command
you want to add.
- Word 98 automatically assigns
the name to a button if there is
no icon assigned. This is a
disadvantage because text
buttons take more room on the
toolbar. To remove the text, press
the Modify Selection button and
click Default Style. Then, use the
Modify Selection menu to assign
a premade icon (click Change
Button Image) or draw your own
(click Edit Button Image). You
can also paste an icon onto a
button (click Paste Button
Image).
- Word 6 gives you a blank
button when there is no icon
automatically assigned. A Custom
Button dialog box appears, which
allows you to add a premade icon
or the name. Press Edit to draw
your own icon.

■ Press the Close button.

Move Buttons
You can move buttons without
opening the Customize dialog box.
Just press the command key while
you drag the button.

Customize Print
Preview
In Word 98 and Word 6, you can
also customize the toolbar in Print
Preview. For example, you can speed
up repagination by adding the Page
Break button. In Print Preview, click
Toolbars on the View menu. Word
automatically selects the Print
Preview toolbar. Click Customize and

follow the steps to
add buttons above.

A little attention to
styles, templates,
and toolbars can
make you more
productive. You’ll
feel smug every
time you avoid the
Brute Strength and
Awkwardness
Method.

Take Control of Microsoft Word

Can’t recall where your files
live? Insert a “document
information” field, followed by
/p, to add your document’s
name and location.

The format painter button is
great when you have a a couple
of paragraphs that need special
formatting.
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Avoid Word’s grammar
checker. Buy a handbook,
such as the Gregg Reference
Manual.
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Membership Form

Check Deposited ❏ Check # ______________________
Check Date ___________________

Charge Deposited ❏ Check/Charge Amount ______________________

For
dBUG
Use
Only

Where did you hear of us? ___________________________________________

Enclosed is my payment of annual membership dues to The Macintosh downtown
Business Users Group starting the month of_______________1999.

Regular Membership: $48.00 $ ______________

Family Membership: Add’l $24.00 $ ______________

Senior Membership (over 65): $36.00 $ ______________

Student Membership: $36.00 $ ______________

❏ Check here if you want information about our Internet connection at $13/month.

❏ Check here if you do not want to be on our free announcement email list ____

    (3-4 posts/month).

Total Amount Enclosed: $ ______________
 ❏ Check ❏ VISA ❏ MasterCard

Credit Card #: ________________________________________________________

Expiration Date: _____________________________________________________

Signature: __________________________________________________________

Please make checks payable to dBUG

Turn in this form with payment to a dBUG cashier at
a main meeting, or mail it to:

dBUG, P.O. Box 3463, Seattle, WA  98114-3463
Please, NO cash by mail; only checks, VISA, or MasterCard.

Date: __________________
Name: ___________________________________________________________

Company: ________________________________________________________

Address: _________________________________________________________

City: _________________________________ State: _____ Zip: __________

Work Phone: ______________________________________________________

Home Phone: _____________________________________________________

Email Address: ____________________________________________________

Special Interest: ___________________________________________________

Are you an iMac owner? _____________________________________________

dBUG ExChange
dBUG’s electronic bulletin
board gives you email,
conferences on a variety of
subjects, chat, and an archive
of shareware and freeware.
It’s a great place to get help
with computer problems.

Internet
For $13 per month, you can
add World Wide Web access
and Usenet newsgroup access
to the email access already
provided as part of regular
membership. Send an email
message to “Inet Cashier” or

call the dBUG InfoLine at 206-
624-9329.

Disk of the Month
Bring a 1.4 MB floppy disk to
the monthly main meeting,
and dBUG will fill it with
useful freeware and
shareware. Please note: dBUG
cannot handle disk sizes other
than 1.4 MB.

User Group Store
Special discounts for user
group members at <http://
www.applemugstore.com/>

Equipment Access:
■ Scanner
Scan an image with a
Microtek Scanmaker X6EL
color flatbed scanner during
SIG or Open House meetings
at the Resource Center.

■ Compact disc
recordable drive
Burn a CD from your hard
drive or Zip cartridges during
SIG or Open House meetings
at the Resource Center. dBUG
requests a $10 donation per
session. (You may burn more
than one disk in a session.)
Blank CDs are available for $6
if you don’t bring your own.
Allow one hour per disk.

■ Digital camera
Take snaps with a Kodak DC50
at main meetings or Resource
Center meetings. Rent the
camera for $25 per week.

For more information,
call the dBUG InfoLine:
206-624-9329
Visit our Web site:
<http://www.dbug.org>

User Group Store Reopens on the Web

Member Benefits

In an effort to boost user group
membership, Apple and PowerMax
have reopened the Macintosh User
Group (MUG) store on the World
Wide Web. The store offers user
group members discounts on:
■ New hardware
■ Equipment factory refurbished

by Apple
■ Used equipment bench-tested

by PowerMax
■ Software
■ Closeout or discontinued

merchandise
■ Apple logo merchandise.
Your purchases give dBUG points
that can be redeemed for selected
MUG store merchandise. The MUG
store is accessible exclusively
through the World Wide Web.

Diane Cohn, Apple’s User Group
Liason, explains that Apple
handpicked PowerMax as its
reseller partner for the MUG store.
“They know their stuff—they’ve
been selling and supporting Apple
products for over twenty years.
PowerMax people believe in
customer service and are commit-
ted to giving user groups priority
treatment.”

To check out the store, visit
<http://www.applemugstore.

com/>. The site is password-
protected, and the login and
password will change quarterly.
The current month’s login is “mug”
and the password is “store.” dBUG

will post login and password
changes on the ExChange.

PowerMax will also give points
to dBUG for members’ purchases
from PowerMax’s Web site. The

MUG store site has a link to
Powermax’s Web site.

Buying from the MUG store is
easy. Just call PowerMax at 1-800-
844-3599, between 7:30 a.m. and
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5:30 p.m. Monday through Friday.
Identify yourself as a dBUG
member, and PowerMax will do
the rest.
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MON TUES WED THURS FRI SAT

Westwind
Computing
510 NE 65th St.
Seattle

2 blocks west of
I-5, on the
northwest
corner   of NE
65th and      NE
Ravenna Blvd.

Identification Statement: dBUG MacNews (USPS 10-435) is
published monthly by the Macintosh downtown Business
Users Group, 1530 Eastlake Avenue East, Suite 308, Seattle,
WA 98102. POSTMASTER: Send address changes to dBUG
MacNews, P.O. Box 3463, Seattle, WA 98114-3463.

Everything in MacNews is ©1999 by either dBUG or the
author of the article. Unless otherwise noted, permission is
granted to other nonprofit MUGs to reprint MacNews articles
as long as credit is given and the information is not
changed or presented in a misleading manner. Opinions in
MacNews do not necessarily represent opinions of dBUG.
Acceptance of advertising by dBUG for publication in
MacNews does not imply any endorsement of the vendor or
product. Trademarked names are not marked with a
trademark symbol because trademark names are used only
in an editorial fashion with no intention of infringement
on the trademark.

What is dBUG?
The Macintosh downtown Business Users Group is a non-
profit educational organization dedicated to the exchange of
information between business users of the Macintosh
computer and related products.

See page 7 for membership information and application.

For additional information, write to:
dBUG Membership Info
P.O. Box 3463, Seattle, WA 98114-3463.
dBUG InfoLine ................................ 206-624-9329

The ExChange {dBUG BBS}
Main Line: ..................................... 206-624-8783
East Side: ...................................... 425-746-2183
N. Snohomish County: ..................... 425-353-7197
S. Snohomish County: ...................... 425-670-2312

dBUG Officers:
President ................................... Ken Winkenweder
Vice President .............................. David Krafchick
Secretary/Treasurer/Cashier ............ Cheryl Malstrom

Board Members:
Membership ....................................... Jim Seifert
Publicity .............................................. Jon Pfaff
Publications ................................... Dona McAdam
ExChange ........................................... Dana Klein
SIG Coordinator ............................. Mark Jacobson

Volunteer Development:
Volunteer Consultant ................... Joyce Schowalter

Internet Connection:
Inet Cashier ........................................ Brian Rush

MacNews:
Editor/Principal Writer ......................... Tish Bailey
SIG Calendar ................................. Mark Jacobson
Proofreader .................................... Sandro Menzel

Submissions:
All articles must be submitted by the seventh of the
month to be included in MacNews for the following
month. Send submissions to <tish_bailey@dbug.org>.

dBUG
Volume 15, Number 7
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Board Meeting
Resource Center
6:30 p.m.

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Open Friday
Resource
Center
6 p.m.

Exchange.com
Resource
Center
11 a.m.

Board Meeting
Resource Center
6:30 p.m.

For last minute info on SIG meetings. . . call 206-624-9329.

iMac SIG
Resource Center
6:30 p.m.

FileMaker Pro
SIG
Resource Center
7 p.m.

No Main
Meeting In
July

HyperCard/
AppleScript SIG
Resource Center
6:30 p.m.

Open Friday
Resource
Center
6 p.m.

Open Friday
Resource
Center
6 p.m.

Open Friday
Resource
Center
6 p.m.

iRobot SIG
Resource Center
6:30 p.m.

Internet Intro
SIG
Resource Center
6:30 p.m.

ExChange SIG
Resource Center
6:30 p.m.

4th Dimension
SIG
Westwind
Computing
6 p.m.

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Open Friday
Resource
Center
6 p.m.

New Member
Orientation

Software
Developers
Workshop
Resource
Center
10 a.m.

Open Friday
Resource
Center
6 p.m.

New Member
Orientation

To take part, just send an email to
<jnewhoff@dbug.org> with a paragraph or two
describing your favorite piece of shareware. You
don’t have to send me the software. I’ll obtain
the most recent version prior to burning the
CD-ROM.

Creating the CD-ROM necessitates having
everything ready in August, so don’t wait! Send
in your submissions now!

Wanted: Shareware…
continued from page 1

EVENTS AND CLASSES

Internet Intro
SIG
Resource Center
6:30 p.m.

The Graphic Artists’ Guild
7/28/99: Streaming technologies for the
Internet (Flash, Shockwave, RealNetworks).
For reservations, call 206-784-1351, on or
before 7/23/99. $15 for Guild members and
students, $25 for nonmembers.
9/29/99: ArtJam 3rd Annual NW Illustrators
show. To participate, call 206-784-1351.
School of Visual Concepts Classes
Learn Photoshop 5, FreeHand 8, QuarkXPress 4,
Javascript, and more. For details, call (206)
623-1560 or visit <http://www.svcseattle.com/>

iMac SIG
Resource Center
6:30 p.m.

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Open Thursday
Resource Center
6 p.m.

Members and
guests only

Exchange.com
Resource
Center
11 a.m.
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